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インストール  
 

Topaz DeJPEG はそれ自体では使用できず、Photoshopなどの互換性のあるホストプログラムを必要

とするプラグインソフトです。 

インストール方法  

１． Photoshopやその他画像編集アプリケーションを起動中の場合は、それらをすべて終了してください。 

２． インストールCD,又はダウンロードしたファイルの“Topaz DeJPEG zip”ファイルを開きインスト

ーラをダブルクリックしてください。インストールウィンドウが開いたら指示に従いインストール

を進めてください。 

 
３． PhotoshopがインストールされていればTopazのプラグインファイルがPhotoshopの“plug-ins” とい

うフォルダ内に自動的にインストールされます。 

４． インストールの後、ライセンスキーもしくはトライアルキーを入力して下さい。 

キー入力  

１． Photoshopにある画像を開きます。 

２． Filters -> Topaz Labs -> DeJPEG -> Menu -> Enter keyへと進みます。 

３． それからコピー&ペースト、あるいはキーを入力します。 

ホスト別インストール  

Topaz Adjustは Photoshopプラグインをサポートするほとんどのホストアプリケーションで動作しま

す。これらのホストアプリケーションには、主に Paint Shop Pro、 Painter、 Irfanviewなどがあります。 

 

Topaz DeJPEGのインストール方法はホストプログラムによって異なります。 

Paint Shop Proや Photo Impact、Irfanviewに Topaz DeJPEGをインストールするには、まず既定の

場所に Topaz DeJPEGをダウンロードして下さい。そして各ホストが指示する方法にしたがってインス

トールを進めてください。以降よりこれらのインストール方法を示します。 
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Paintshop Pro / Photo Impactへのインストール方法  

１． まず PaintShop Pro / Photo Impactを起動して下さい。 

２． “File Types”リストの中で“Plug-ins” を選択し、Menu file -> Preferences -> File Locationsから

“Add”をクリックして下さい。 

 
 

３． C:\Program Files\Topaz Labs\Topaz DeJPEG 3 plug-ins を選択し、“OK”をクリックして下さい。 
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4. Topaz DeJPEGが使用できます。Effects -> Plugins へ進み “Topaz DeJPEG 3”を選択して下さい。 
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Irfanviewへのインストール方法  

１． Irfanview ウェブページ (http://www.irfanview.com：英語)にて入手可能な Plugins/Addonsをインス

トール済みであることを確認してください。 
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２． Irfanviewを開き、 Image -> Effects -> Adobe 8BF filtersに進んで下さい。 

 
 

３． ポップアップスクリーンで “Add 8BF filters”を選択し the C:\Program Files\Topaz Labs\Topaz 

DeJPEG \Plugins フォルダを選択して“OK”をクリックして下さい。Available/Loadable 8BF 

Filters セクションに“Topaz DeJPEG 3”が表示されるようになります。 
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４． Topaz DeJPEGを使用するには、Image -> Effects> Adobe 8BF filtersと進み、“Topaz DeJPEG 

3”を選択してください。 
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製品紹介  
 

JPEGノイズ  （圧縮により発生するムラ）  

 JPEG圧縮ノイズとは？  

JPEG圧縮ノイズとは、JPEG形式によって画像データを圧縮した際にランダムに生じる画像ムラのこ

とを示します。たいてい、ブロックやドット、縞模様としてこのムラが確認できます。これらはチェッ

カーボーディングやモスキートノイズという名で知られています。画像を拡大してチェッカーボード模

様やモスキートノイズ、曖昧さ、細部の欠落、鮮明さの欠落、まだらな色合いなどがあれば、圧縮によ

る JPEGノイズが生じているということになります。 
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JPEG圧縮ノイズの原因は？  

JPEG圧縮ノイズは JPEG形式として画像を保存するときの損失の大きい圧縮により生じます。JPEG

では画像圧縮率を変更することが出来ます。圧縮率を上げると画質が下がりファイルサイズも小さくな

ります。逆に圧縮率を下げると画質が上がりファイルサイズも大きくなります。 

 

JPEG圧縮ノイズの影響  

 JPEGはその圧縮率の高さから広く使用されています。しかし圧縮後の画質は劣化し、一度圧縮する

と画質を元に戻せないというリスクを伴います。その結果ノイズが出現します。画質が元に戻らないた

め、JPEGによって同じ画像を圧縮するたびに画質が劣化していくことになります。 

 

  

JPEG圧縮ノイズを除去するためになぜノイズ低減ソフトは使用できないのか？  

 一般的に、ノイズ低減アルゴリズムでは劣化の激しい圧縮方法により生じる JPEGノイズを低減する

ことはできません。Photoshopには基本的な JPEGノイズ低減機能が備わっていまが、それは Topaz 

DeJPEGのようにモスキートノイズの低減や、変色の復元、鮮明さの復元には特化していません。 

 

Topaz DeJPEG 

 Topaz DeJPEG 

 Topaz DeJPEGは JPEG圧縮ノイズにより劣化した画像を復元する最先端の画像処理技術を用いた

Photoshopプラグインです。これは JPEG圧縮ノイズを修正する最適な方法です。 

 

 JPEGは圧縮率が高く高性能であることから、現在ほとんどのデジタル画像に JPEGが採用されてい

ます。しかしながらその代償として JPEG圧縮ノイズという犠牲を伴います。高圧縮率で画像を圧縮す

れば、これらの JPEGノイズはよりはっきりと現れ画質に影響を及ぼします。 
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Topaz DeJPEG 3.0適用前 

 

 
Topaz DeJPEG 3.0適用後 
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 Topaz DeJPEG は洗練されたアルゴリズムを用いて設定の微調整や調整用レイヤの作成に時間をかけ

ず効率的な画像補正を提供します。さらに、いくつかのサンプルレイヤを適用した補正画像が確認でき

るプリセット機能が用意されているため、それらを基準として微調整をすることで効率的な画像補正が

可能となります。 

 

 Topaz DeJPEG は画像の細部を保ちながら、JPEG 圧縮ノイズを除去してくといういまだかつてない

操作をユーザに提供します。 

 

    
付加逆圧縮による球    可逆圧縮による球 

 

Topaz DeJPEGの主な機能を以下に示します。 

１． 最適な JPEG 圧縮ノイズ除去機能を提供します。これは画像の細部をできる限り保持しながら、

ほとんどのノイズを除去します。 

２． チェッカーボード模様やモスキートノイズといった JPEGノイズを最適に除去します。 

３． 画像の細部を鮮明にし、ほぼ完全な状態に復元します。 

４． JPEG圧縮によって不明瞭になった部分やぼけている部分を修正します。 

５． エッジを鮮明に見せる効果があり、高品質で一見鮮明な JPEG 画像におけるエッジでさえさら

に鮮明に見せることができます。 

 

DeJPEGの新機能  

 Topaz DeJPEG 3.0 は DeNoise に見られる強力なノイズ低減能力を有し、それに高速処理や画像細部

の保持、画像のスムージングや鮮明化の能力が組み合わさっています。これらの機能より、ユーザは修

正したいと思うノイズの種類に注目して画像修正を加えることが可能となります。 
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作業領域  
 

インターフェース  

 Topaz DeJPEG の操作ウィンドウを見ると一見難しそうに見えますが、そのようなことはありません。

多様な機能を理解しやすいように下図のように５つのセクションに分けて説明します。 

 

 
  

 

 

 

プレビューセクション  

 プレビューセクションとは編集中の画像表示部分のことで、右上の大きな画面を示します。スクロー

ルするには画像上で左クリックして画像をつかみ、そのままマウスを上下左右に移動します。左ボタン

を離すと画像は定着します。 

２．プリセット 
あらかじめ設定

されたパラメー

タを適用できま

す。 

１．プレビュー 
編集中のプレビ

ュー画像を表示

します 

３．メニュー 
ユーザ設定を有

効にしたり、そ

の他のオプショ

ンを設定しま

す。 

５．プレビューナビゲータ 
プレビュー領域の操作につい

て誘導します。 

４．パラメータと設定 
さまざまな効果を調整するた

めのつまみを調節します。 
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 元の画像を確認するには “View Original Image”ボタンを押してください。離すと編集中の画像に戻

ります。また、スペースキー押下で同様の操作ができます。 

 

 
  

 
 

  プレビュー画面左下の“+”や“‐”ボタンによって画像の拡大・縮小ができます。“100%”ボタ

ンでは画像の元の大きさを表示します。 
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Photoshop と同じく、“Ctrl +” と “Ctrl –”により画像の拡大・縮小が可能です。矢印キーにより現在選択

されているスライダーの調節が可能です。ショートカットキーの全リストはこのマニュアルの後半に記

載されています。 

Photoshopおよびその他ホストソフトウェアはグレースケール、 RGB、LAB、CMYKなどを含む多く

の画像モードをサポートします。画像はチャンネルごとに、8, 16, あるいは 32 ビットの画像を処理する

ことができます。Topaz DeJPEGはチャンネルごとに 8、16ビットの両方をサポートします。 

Topaz DeJPEG は RGBモードのみサポートします。モノクロ写真においては最初に RGBモードに変

換します。 

 

プリセット  

 プリセットを使用することによって Topaz DeJPEG における全作業を単純かつ高速にすることができ

ます。プリセットはあらかじめ設定されたパラメータをいつでも画像に適用し、おおよその補正イメー

ジをつかむのに非常に役立ちます。 

 本ソフトにはいくつかのプリセットがデフォルトで用意されています。これらは個々の画像によって

それぞれの効果を示しますが、画像を編集する際の基準として非常に役立ちます。 

 

プリセットの適用方法  

 プリセットの適用方法は直感的で容易です。好みのプリセットをクリックすることで、すべてのパラ

メータが自動的に選択されたプリセットに合うように設定されます。思い描く完璧なイメージを得るに

はプリセット設定後、タブにおいてパラメータを微調整してください。 

 個々のプレビューの代わりにリストモードでプリセットを見たい場合、Preview メニューをクリック

して“Toggle list/Thumbnail”を選択してください。リストビューを使用することでサムネイル画像の読

み込みが必要ないため Topaz DeJPEGの動作を高速化できます。 
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プリセットプレビューの表示更新  

 メインプレビュー画面の拡大や縮小、表示移動してから、プリセットのサムネイル画像にそのメイン

と同じ部分を表示したい場合は、 Refreshボタンをクリックしてください。その後すべてのプリセット

に反映されます。 

 
 

プリセットメニュー  

 Topaz DeJPEG には複数の多様なパラメータがあるため、プリセットの設定や後で使用するための設

定を保存する機能は非常に便利な機能です。設定を保存するためには、“Preset…”をクリックしてか

ら“Save…”ボタンをクリックしてください。 
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 プリセット名と任意の記述を入力し“OK”をクリックして下さい。入力した名前がすでに存在する場

合、新しいプリセットを作成する代わりに、Topaz DeJPEGは既存のプリセットを上書きしますのでご

注意下さい。また DeJPEG のプリセットフォルダ内をテキストエディタにより手動で書き換えない限り、

すでに提供されているデフォルトプリセットを上書・削除することはできません。保存したプリセット

は拡張子“.tpp”で新規ファイルとして保存され、直ちにプリセットメニューに追加されます。適用した

い場合はプリセットクリックするだけです。 

 

プリセットの削除  

 プリセットを削除したければ、“Delete…”をクリックしてください。 

 

注）デフォルトのプリセットは上書き・削除できません。 

 

プリセットの共有  

 保存したプリセットファイルを Topaz DeJPEGをインストールしている他のユーザに eメールで転送

し、そのファイルを Presetsフォルダにダウンロードすることで共有することができます。 

保存したプリセットは Topaz DeJPEGをインストールした C:\Program Files\Topaz Labs\Topaz 

DeJPEG 3\Presets内の“Presets”フォルダ内にあります。それ以外のフォルダにインストールした場合は

上記フォルダ以外に保存されます。 

Macユーザの方は HD/Library/ApplicationSupport/TopazLabs/DeJPEG3/Presets内に保存されます。 
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プリセットのインポート／エクスポート  

 プリセットファイルをインポートするには、“Import…”ボタンをクリックして下さい。 

 

 
 

 以下のようなブラウズボックスが開き、コンピュータにダウンロードしてあるプリセットをインポー

トできます。 

 

 
 

 インターネットから直接インポートしたい場合は、“Import from Internet…”ボタンをクリックし、

以下の入力画面でプリセットファイルがあるフォルダの URLを指定してください。 
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 プリセットファイルを特定の場所にエクスポートするには、“Export…”をクリックしてください。

その後、このファイルをインポートした他のユーザと共有できるようになります。 

 

 

スナップショット  

 Topaz DeJPEG v3.0より新機能としてスナップショットが追加されました。スナップショットボタン

プリセットパネルの下にあります。 

 

 
 

 スナップショット機能は作成した画像をプリセットとして保存することなく２つまでのセッティン

グを比較することを可能とします。たとえば、ある画像において２つの異なる設定がどう作用するかを

確認したい場合、その両方をプリセットに保存、適用、削除することなくスナップショットに保持する

だけで簡単に比較することができます。 

現在の設定をメモリに保持するためにスナップショットを使用するには、単純に“Snap 1 ”もしくは

“Snap 2”をクリックしてください。“Recall 1 ”もしくは“Recall 2”をクリックすることでプリセ

ットの操作と同じように“Snap 1 ”もしくは“Snap 2”の設定をプレビュー画像に適用することが出

来ます。ただし、Topaz DeJPEGで使用しているスナップショットは Topaz DeJPEG起動中のみ使用可

能であるので Topaz DeJPEG終了時、これらのスナップショットはすべて削除されることにご注意くだ

さい。 
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プレビューナビゲータ  

 プレビューナビゲータによって現在プレビューされている範囲がどの部分なのか知ることができます。

また、ナビゲータの赤枠をクリックアンドホールドによってつかみ、スクロールすることもできます。 
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メニューと設定  
 

Menu（メニュー）  

 フィルタウインドウの右下にある“Menu”ボタンより Topaz DeJPEG のメニューにアクセスできま
す。 
 

    
 

Preferences 

Topaz DeJPEG ウインドウのビジュアルカラーや他の追加機能を設定できます。OK をクリックする

とチェックされた設定が保存されます。 

 

 
 

“Enable popup help”はマウスがフィルタエリアでホバリングした時に表示するツールチップ(ふき

だしによる説明)を有効にします。もし作業の妨げとなるようでしたらオフにして下さい。 

“Pan preview faster ”は Topaz DeJPEGプレビューのパン速度（プレビューをつかんで移動させる

速度）に影響します。 
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“Disable multi-processor support”は Macユーザにのみ使用可能となります。 

 

Check Update  

ユーザのコンピュータにインストールされている Topaz DeJPEG のバージョンをチェックでき、最新

バージョンが入手可能であればお知らせいたします。 

 

 
 

Enter Key  

ライセンスキーの入力に使用します。 

 

 
 

User’s Guide 

このユーザーズマニュアルを開きます。 

 

Technical Support  

Topaz Labsのテクニカルサポートページを表示します。 

 



:  ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 
24/24 

Online Resource 

 ビデオチュートリアル（使用例）などが得られる Topaz DeJPEG のホームページにリンクします。 
 

About  

Topaz DeJPEG のバージョン情報およびホームページアドレスを表示します。 

 

Share / Copy Settings to Clip Board 

 現在の設定を e メールやフォーラムに自動的に添付する機能です。これは設定を共有したいけれど保

存やプリセットのエクスポートが面倒なときに便利です。 
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設定とパラメータ  
 

 Topaz DeJPEG には最適な画像を得るために２つの設定タブと合計 10 個のパラメータが存在します。 

Main（メイン）  

 “Main”タブには“Reduce Artifacts（ノイズの低減）”、“Smooth Color（色の滑らかさ）”、

“Sharpen（鋭さ）”、“Sharpen Radius（鮮明さの範囲）”といった４つのパラメータがあります。 

 

 

 
 

Reduce Artifacts（ノイズの低減）  

 これは本フィルタのメインとなるパラメータです。高い値ほど JPEG アーティファクト（JPEG 圧縮

による画像ムラ）を低減し、やわらかい印象を与えます。大体の調節方法としては、まず低い値から始

め、エッジの鮮明さを損なわない程度にアーティファクトが除去されるまでつまみを上げていくといっ

た要領になります。 

 

Smooth Color（色の滑らかさ）  

 画像の色ムラが生じている部分を滑らかにします。高い値ほど色ムラが滑らかになりますが、画像の

詳細は損なわれていきます。 

 

Artifacts 
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Sharpen（鮮明さ）  

 JPEG ノイズ除去により印象がやわらかくなりすぎた画像にメリハリを付けるためにエッジを鮮明に

します。Sharpen Radiusパラメータと相互に作用します。 

 

Sharpen Radius（鮮明さの範囲）  

 鮮明にするエッジの大きさ（範囲）をピクセル単位で変更します。高い値ほど不鮮明な範囲が大きい

部分に作用し、低い値ほど不鮮明な範囲が小さい部分に作用します。 

 

 Reduce Artifactsパラメータはより細かなノイズ除去にのみ使用することになるでしょう。 

 使いすぎるとエッジの鮮明さが損なわれることにご注意ください。 

 さらに高度な調整については Advancedタブを使用してください。 

 

Advanced 
 “Advanced”タブには“Luma Noise（ルマノイズ）”、“Color Noise（カラーノイズ）”、“Color 

Edge Radius（カラーエッジ範囲）”、“Edge Threshold（エッジ閾値）”、“Saturation（彩度）”、

“Add Grain（斑点付加）”といった６つのパラメータがあります。 

 

 
 

Luma Noise（ルマノイズ）  

 輝度におけるムラを軽減します。Lumaは Luminance（輝度または白黒）を意味します。 
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Color Noise（カラーノイズ）  

 色の持つムラを軽減します。 

 

Color Edge Radius（カラーエッジ範囲）  

 鮮明度を高めるためのカラーエッジ範囲を指定します。アーティファクト除去により損なわれた色の

詳細を取り戻します。 

 

Edge Threshold（エッジ閾値）  

 色差によるエッジを強調する度合いを変更します。 

 

Saturation（彩度）  

 彩度を上げ、アーティファクト軽減により損なわれた色味を取り戻します。 

 

Add Grain（斑点付加）  

 さらに自然に仕上げるためにモノクロの斑点を付加して明暗を調節します。 

 

カラー表示モード  

 
 

Normal 

 通常の画像を表示します。 

 

Luma 

 画像が含む輝度をモノクロ画像で示します。 

 

Color 

 画像の色成分を示します。 
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パラメータのリセット  

 “Reset Tab”ボタンによりタブの設定をデフォルトに戻します。“Reset All”ボタン

によりすべてのタブにおけるパラメータをデフォルトに戻し、元の画像を表示します。 
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操作の流れ  
 

サンプルプロジェクト  

 本セクションでは、本ソフトの操作により馴染むために、実際の操作例を示します。 

 

   
適用前      適用後 

 

上の DeJPEG適用前後の写真を比較すると、ノイズが低減されていることに気づくと思われます。以

降より、最適な画像を得るための操作方法を示します。 

 

１． Photoshopを起動して画像ファイルを

開きます。 

２． 画像の複製レイヤを作成します。レイ

ヤ上で右クリックして“Duplicate 

Layer（レイヤの複製）”を選択してく

ださい。またはレイヤを赤枠に示す

“新規レイヤ”アイコンまでドラッグ

してください。 

 暗い部分の画像を最良にするために

“Auto-Bright（明るさ自動調整）”を 湯有

有効にしてください。 
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３． DeJPEGを起動するために Photoshopのメニューから Filters ->Topaz Labs ->Topaz DeJPEG 3と

進んでください。 

４． 表示されているプレビュー画像をつかんで編集したい位置に調整してください。画像データが大き

くて移動が遅い場合は、右下のメニューから“Preferences…”より“Pan preview faster”にチェッ

クを入れてください。 

 
５． 左側のプリセットパネルより自分のイメージする画像に近いものがあればダブルクリックしてプレ

ビューに適用できます。各パラメータのつまみが自動的に動き、選択したプリセットの設定に合わ

せられます。 

６． カラーモードを“Normal”から“Luma”に変更します。これは色ノイズ以外のノイズを確認するた

めのモードとなります。 

その後“Color”モードに変更すると、ほとん

どのアーティファクトが除去されているのが

わかります。 

 

７． 再び“Luma”モードにし、“Main”タブの

“Reduce Artifacts”を納得のいくまで調節し

てください。高い値はエッジをやわらかな印

象にするため、低い値からゆっくり調節する

ことをお勧めします。 
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８． 次に“Sharpen”の調節です。“Reduce Artifacts”の調節によりエッジの印象が弱まったと感じた

ら、このパラメータを調節してください。エッジの荒さを感じたなら“Sharpen Radius”を調節し

てください。高い値はぼやけた部分に効果的です。 

 

この時点で JPEGアーティファクトはほとんどなくなっていることでしょう。さらなる調整が必

要なら次のステップに進んでください。 

 

 最良の画像を得るには納得のいくまで調整を実行することです。パラメータはたくさんあります

が、それほど難しく考えずに操作してください。 

 

９． 次に“Color”モードに変更してください。 

 

 
色ムラがある場合は“Smooth Color”を調節して滑らかにしてください。 

Artifacts 
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１０． 次に Advancedタブの調節です。まだノイズが見られるようなら“Luma Noise”や“Color 

Noise”を調節してください。“Luma Noise”の調節時は“Luma”モードに、“Color Noise” の

調節時は“Color”モードに切り替えてください。これらの操作により、よりきれいな画像が得られ

ます。 

 
 

１１． “Clr Edge Radius”によりカラーエッジの細部を修正できます。また、エッジの強調度合いを

“Edge Threshold”によって調節してください。 

１２． 色彩はアーティファクト軽減時に淡くなる場合があります。これを修正するには“Saturation”

を調節してください。色彩が回復し、彩度のバランスがよくなります。 

１３． 最後に、全体的にもう少し自然な仕上がりにするために“Add Grain”を調節してください。こ

の値のデフォルト値は 0.05となっています。 

１４． “Normal”モードに戻し、必要なら微調整をしてください。満足のいく画像に仕上がったら、

“OK”をクリックします。 
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これでアーティファクトのない画像が出来上がりました。 
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よくある質問  
 

 “Photoshopのフィルタメニューに Topaz DeJPEGが見当たりません。”  

Windowsご使用の方： 

１． C:\Program Files\Topaz Labs\Topaz DeJPEG 3\Plugins内の tldejpeg3.8bfファイルをコピーしてく

ださい。 

２． 通常 C:\Program Files\Adobe\Adobe Photoshop CSx\Plug-Ins に位置する Photoshopの Plug-Insフ

ォルダ内の Topaz DeJPEGに関連する全ファイルを削除してください。Topaz DeJPEGや

tldejpeg3.8bfというファイル名が付けられているはずです。その後先ほどコピーした tldejpeg3.8bf

を貼り付けてください。 

３． Photoshopを終了し、再起動してください。Topaz DeJPEGがフィルタメニュー内に表示されるは

ずです。Topaz DeJPEGを使用するには事前に画像を開いている必要があります。 

 

Macご使用の方： 

１． /Library/Application Support/Topaz Labs/ DeJPEG 3/Pluginsフォルダ内の Topaz_dejpeg3.pluginフ

ァイルをコピーしてください。 

２． Applications/Adobe Photoshop CSx/Plug-Ins (もしくは Photoshop Plug-Ins フォルダがある場所)。 

Topaz DeJPEGに関連するファイルすべてを削除してください。その後、右クリックより先ほどコ

ピーした Topaz_dejpeg3.pluginファイルを Photoshop Plug-Insフォルダ内に貼り付けてください。 

３． Photoshop を再起動し、Topaz DeJPEGがフィルタメニュー内にあることを確認してください。

Topaz DeJPEGを使用するには画像を開かなければなりません。 

 

 “プリセットが見れません。”  

おそらくお使いのプリセットファイルが読み込み不可となっているからです。Macにおいては、

“/Library/Application Support/Topaz Labs/ DeJPEG 3”をチェックし、Presetsフォルダにて右クリック

してください。すべてのユーザに対して少なくとも読み込み可能となっているかどうかを確認してくだ

さい。プリセットを保存したい場合は、書き込み可能にする必要があります。 

また、規定のフォルダにインストールされていない場合は、プリセットは表示も保存もできません。 

 

“どこにキーを入力すればよいですか？”  

 キー入力のため、まず Photoshopにて画像を開きます。Filters -> Topaz Labs -> DeJPEG3 -> Menu... 

-> Enter key...と進み入力画面が表示されます。 
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用語集  
 

アルゴリズム‐問題を解くための効率的手順を定式化した形で表現したもの。 

チェッカーボーディング‐チェッカーボードのような大きな画素ブロックの形をした歪み。通常は圧

縮率の高い画像に生じ、特に情報量の多い領域に見られる傾向があります。 

カラーチャネル‐主要な色の組み合わせで多彩な色を表現するデジタルカラー画像のカラー要素。典型

的なデジタル画像では Red（赤）、Blue（青）、Green（緑）をカラーチャネルとする RGBカラーモデ

ルが使用されます。 

カラーノイズ‐不鮮明なエッジに見られるデジタルノイズ、または画像の色ムラや不自然な点の集合。 

圧縮アーティファクト‐不可逆圧縮による画像や映像に見られる歪み。 

ダウンロード‐あるデバイスから他の端末へのデータ転送プロセス。 

エッジアーティファクト‐画像内のエッジに見られるアーティファクトや歪み。 

エクスポート‐転送しようとしているデータを他のプログラムが使用可能な形式に変換すること。 

画像圧縮‐画像データの圧縮。不可逆圧縮、特にデータ量の少ないものは圧縮によりデータが失われ、

より多くのアーティファクトを発生させます。最も広く使用されている画像圧縮形式は JPEGです。 

インポート‐入手しようとしているデータをファイルやドキュメント形式に変換すること。 

可逆圧縮‐本質を保ちつつデータサイズを削減する再生可能な圧縮方法です。 

不可逆圧縮‐データを近似することでサイズを削減する再生不能な圧縮方法です。 

ノイズ‐デジタルカメラにより撮影された画像に生じる干渉をいい、画像にランダムな色合いにちりば

められた点や、均一な色が続く領域に見られるムラとして確認されます。たいていは暗い部分や影にな

っている部分に発生します。ノイズは全体的な画質を損なう望ましくない効果であるか、もしくは芸術

的な効果として使用される場合もあります。 

パン‐カーソルをプレビューの上でクリックしてそのままドラッグすることでプレビュー画面を自由に

移動させる機能。 

パラメータ‐目的となる結果に変化を与えるいくつかの変数のうちの一つ。 

プラグイン‐システムの向上のために追加できるモジュールやソフトウェア。 

プリセット‐製品にあらかじめ備えられているパラメータと設定。Topaz製品にはデフォルトプリセッ

トが備えられています。また、プリセットが示す効果を一目で確認できるサムネイル画像が備わってい

ます。 

プレビュー‐編集中の画像表示。プレビューセクションは右上の大きな画面となります。 

スムージング‐表面を滑らかにすること。目に見える突起、こぶ、へこみを平らにします。 
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CMYK‐プリンターによる印刷において使用されるシアン、マジェンダ、イエロー、ブラックの 4色を

使用したカラーモデルをいいます。 

Grain‐画像を自然に見せるために使用する軽い斑点の集合のようなノイズ。 

ISO‐デジタルカメラにおけるセンサの感度を示します。ISO が高いほどシャッタースピードは速くなり、

暗いところでの撮影に向いていますが、ノイズが増加しやすくなります。 

Luma‐画像の輝度（色のないモノクロの領域）。Lumaは色のない画像を示し、Chromaは色情報を示

します。 

RAW画像‐圧縮やノイズ除去などされていない未加工の画像。 

RGB‐Red（赤）、Green（緑）、Blue（青）を基本としてすべての色を表現するカラーモデル。デジ

タルカメラやコンピュータのモニタに使用されているモデルです。 
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ショートカットキー  
 

作業効率アップのため Topaz DeJPEGではいくつかのショートカットキー が使用できます。以下のキー

は全工程にて使用可能です。 

動作  Mac Windows 

オリジナル画像の確認 SPACEBAR SPACEBAR 

スナップショット１の呼び出し CMD-1 CTRL-1 

スナップショット２の呼び出し CMD-2 CTRL-2 

スナップショット１の保存 ALT-1 ALT-1 

スナップショット２の保存 ALT-2 ALT-2 

現在作業中のタブのリセット CMD -R CTRL-R 

すべてリセット CMD -ALT-R CTRL-ALT-R 

画像サイズを画面にフィット CMD -0 CTRL-0 

画像の 100%表示 CMD -ALT-0 CTRL-ALT-0 

拡大 + or CMD -+ + or CTRL-+ 

縮小 - or CMD - - - or CTRL- - 

 

Mac ユーザの方： CTRL キーの代わりに CMD を使用してください。 

パラメータのつまみにフォーカスがあれば（たいていはクリックによる）、値変更のため以下のキー

が使用可能です。 

←、↑ 0.01ごと減少 

→、↓ 0.01ごと増加 

Page up 0.1ごと減少 

Page down 0.1ごと増加 

Home 最小に設定 

End 最大に設定 

 

最後にプリセットウインドウにフォーカスがあるとき、プリセットを選択するために↑、↓キーが使

用可能です。 
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製造元  
 

NIXUS（北海道日興通信株式会社）所在地 
〒060-0041  
札幌市中央区大通東７丁目１２番地３３水野ビル 
TEL：011-251-4251（代表）、011-251-4381（システム部） 
FAX：011-251-4564 
http://www.nixus.jp 
 

Topaz Labs LLC 所在地 
5001 Spring Valley Road  
Suite 400 East  
Dallas, TX 75244  
Phone: 972.383.1588  
Fax: 866. 876.1393  
 

技術サポート 
NIXUS： 
http://www.club-nixus.jp 
support@hnikko.co.jp 
 
 

Topaz Labs LLCはダラス、テキサスの私企業で、高度な映像および画像補正技術の開発に取り組んでい

ます。今日広く使用されているデジタルスチルカメラや、デジタルビデオカメラ、HDTV などとともに、

高画質なデジタル画像および映像のニーズは非常に高まっています。Topaz Labsの使命は実験的な最先

端の画像・映像補正技術をプロや一般の顧客に提供することです。 
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Topaz製品ラインナップ  
 

画像プラグイン  

 

 

  

  

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

画像における露光、詳細、色

彩の総合的コントロールが写

真をポップに仕上げます。 

高度なノイズ軽減手法により

画像の細部を保持しつつ楽に

ノイズを取り除くことができ

ます。 

どんな写真でも美しい絵画の

ように仕上げることができま

す。 

はっきりとした画像を創りま

す。また、凹凸を平らにする

効果もあります。 

画像の鮮明度の向上、再構

成、引き伸ばし、高品質ノイ

ズ除去、JPEG圧縮補正にお
ける総合的な画像補正ができ

ます。 

高度な JPEG圧縮アーティフ
ァクト除去フィルタにより画

像の詳細を保ちつつ JPEG圧
縮アーティファクトを除去す

ることができます。 
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映像プラグイン  

  

容易に、効果的にビデオフレ

ームを捕らえ、画質と解像度

を向上させます。 

超解像技術を活用しながら最

適な映像補正フィルタにより

映像を向上させます。 


